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1)  INTRO Jimmy & Rachel

@jfwong - @wachelreeks - @commandcast

We’re taking a look at some of the new multicolored Commanders coming out in All Will Be One and

there are some very exciting ones to talk about this time. BUT BEFORE WE GET INTO THEM:

**CARD KINGDOM** **ULTRAPRO #1** **GK LIVE PHILLY** **PATREON: THOMAS BROOKS**

2) MAIN TOPIC: MULTICOLORED COMMANDERS - ALL WILL BE ONE

There are 12 new multicolored legendary creatures in Phyrexia: All Will Be One; so we won’t have time to

cover them all. The ones we skipped are very similar to commanders we’ve covered in the past or are

more balanced for 1v1 formats.

ATRAXA, GRAND UNIFIER

NOTE: Card type Battle??? We haven’t seen this before!

NOTE: Great card selection, could be a combo Commander–particularly if the combo is two different card

types–but could be too expensive to be all that competitive. Reminds me of Niv-Mizzet Reborn, but easier

to build around. Generally, this is very open ended and could be whatever you want it to be.

BLINK ME!! This card is screaming to be blinked, cloned, sacrificed, and reanimated. 7 mana is no joke,

even with four colors.

● Blink it > Ephemerate; Thassa, Deep Dwelling;

● Clone it > Irenicus’s Vile Duplication; Spark Double;

● Bring it back > Malakir Rebirth; Kaya’s Ghostform;

SO MULTI-TYPICAL Keep in mind, when you’re building this deck, to vary card type as much as possible.

Play cards with multiple card types to help draw even more!

● Enchantment Creatures > Dryad of the Elysian Grove; Destiny Spinner; Gloomshrieker;

● Artifact Creatures > Ornithopter of Paradise; Phyrexian Metamorph;

● Artifact Lands > Seat of the Synod; Razortide Bridge (Modern Horizons 2 cycle)

○ BEWARE the regular Artifact lands can get blown by cards like Vandalblast.

● Tribal Spells > Bitterblossom; Lignify; Crib Swap

○ Not listed on the card but still counts.



RAMP IT UP 7 mana is a lot of mana! You’re going to need quite a few cards dedicated to ramping out

your Commander and casting all the cards you’ve drawn.

● Ramp > Mirari’s Wake; Bloom Tender;

● Cheat Into Play > Hunting Grounds; Omniscience; Show and Tell; Kodama of the East Tree;

HIGH CMC Speaking of 7 mana, there are some cards that reward you for playing a commander with

high mana value.

● Stinging Study; Majestic Genesis; Cloudkill (kills Atraxa); “Visions cycle” - Visions of Dominance;

Visions of Dread; Visions of Duplicity; Visions of Glory

NOTE: A word of warning. I think Commander players have a tendency to look at ETBs and abuse those

as much as possible. Do not forget that your commander is a 7/7 with flying, vigilance, deathtouch, and

lifelink. Attack!

EZURI, STALKER OF SPHERES

PROLIFERATE It says, “Whenever you proliferate,” so let’s do that!

● Flux Channeler; Evolution Sage; Inexorable Tide; Smell Fear;

● New Cards > Cankerbloom; Unnatural Restoration; Tekuthal, Inquiry Dominus;

● Your Commander > Planar Incision; Teferi’s Time Twist;

Now you have to answer the all important question: what are you proliferating? There are lots of good

options in these colors. I would pick a direction and focus the deck around it. You can include a variety,

but know which one your deck is using to win.

COUNT ON IT +1/+1 counters

● Defiler of Vigor; Mindless Automaton; Master Biomancer; Biophagus; Master Chef; Simic

Ascendancy;

● Combo Potential > Sage of Hours; Ezuri, Claw of Progress;

CHARGE IT UP Charge counters

● Everflowing Chalice; Astral Cornucopia; Replicating Ring; Blast Zone; Strixhaven Stadium;

● Combo Potential > Magistrate Scepter;

CALL THE GATEWATCH Loyalty counters

● “Best” Walkers > Narset, Parter of Veils; Oko, Thief of Crowns; Teferi Master of Time;

● Can Ult With 1-2 Proliferates > Nissa, Vital Force; Tamiyo, the Moon Sage; Tezzeret Betrayer of

Flesh; Tamiyo Compleated Sage;

● Support > Doubling Season; Deepglow Skate; Ichormoon Gauntlet;

● NOTE > Planeswalker decks are a grind to play against and can often make for slow games. Build

with wincons and study up so you know what your Planeswalkers do! Coming from experience,

it’s actually not that fun to jam all the walkers you own into a Superfriends deck and see what

happens.

COMPLEAT THE GATEWATCH Poison counters

● Blighted Agent; Viral Drake; Triumph of the Hordes; Corrupted Conscience; Spinebiter;

● Unblockable effects are very powerful in this deck - even cards that grant Flying or Menace

SIMIC VALUETOWN Or just draw a lot…
● Pir, Imaginative Rascal; Toothy, Imaginary Friend;

● Ominous Seas; Midnight Clock; Mindless Automaton;



GLISSA SUNSLAYER

First strike and deathtouch is a brutal combination that means you will likely connect when you attack…
NO BLOCKS Glissa wears equipment well.

● Attack Triggers > Sword of the Animist; Staff of Titania;

● Damage Triggers > Mask of Memory; Wand of Orcus; Quietus Spike;

● Trample > Scepter of Celebration; Sawtusk Demolisher; Gemrazer;

BAD TOUCH Deathtouch is a powerful keyword on a commander.

● Forced Block > Lure; Grappling Hook; Shessra, Death’s Whisper; Tempting Licid

● Bite Effects > Spinning Wheel Kick; Viridian Longbow

COUNT BACKWARD The build-around that stands out to me is the ability to remove counters.

● Sagas > Binding the Old Gods; Eldest Reborn; Phyrexian Scriptures;

● Cumulative Upkeep > Elephant Grass

● -1/-1 Counters > Devoted Druid; Wall of Roots;

○ Build all the way around them - Hapatra, Vizier of Poisons

○ Check out JLK’s deck for lots of ideas in this world

● Ice Counters > Dark Depths

● Similar Effects > Hex Parasite; Power Conduit

NOTE: I did try a version of this build and it tends to be VERY controlling. There aren’t a ton of

green/black sagas that progress the game to the point where it is worth it. Just a lot of repeated edicts.

JOR KADEEN, FIRST GOLDWARDEN

This equipment deck is go-wide vs. go-tall. Comparable to Akiri, Fearless Voyager rather than Akiri,

Line-Slinger.

THE EQUIPMENT He wants a lot of equipment. So I like cards that make token equipment, have cheap

equip costs or draw cards.

● Toggo, Goblin Weaponsmith; Bloodforged Battle-Axe; Skullclamp; Shuko

THE EQUIPPED Swords don’t do anything without a creature to hold them!

● Reckless Crew; Goldwardens’ Gambit; Akki Ember-Keeper; Koll, the Forgemaster; Puresteel

Paladin;

DOUBLE-EDGED SWORD It’s hard to balance equipment with creatures, so a few cards that do both are

helpful. Goes well with the For Mirrodin! mechanic in the main set and the Rebellion Rising precon.

● Glimmer Lens; Citizen’s Crowbar; Nettlecyst; Lizard Blades;

MODIFIED There are decent payoffs for this, thanks to Neon Dynasty.

● Kami of Celebration; Akki Battle Squad;

○ Don’t forget that Equipped = Modified, but Modified doesn’t necessarily only = Equipped

NOTE: Put Jor Kadeen in an Isshin equipment-themed deck!

***MIDROLL POINT*** We have 4 more multicolored legends to talk about including a Phyrexian

Elephant Wizard and a five-color commander for a previously unsupported creature type.



KETHEK, CRUCIBLE GOLIATH

This deck wants to sacrifice creatures with high mana values to cheat impactful creatures into play.

SAC FODDER

● Bring Themselves Back > Rekindling Phoenix; Wave of Rats;

● High MV, Reduced Cost > Writhing Necromass; Molten Monstrosity; Marshmist Titan;

● ETB/Dies > Obsidian Charmaw; Markov Enforcer; Mezzio Mugger (Blitz);

CHEAT DEATH

● Dodge Mana Cost > Sneak Attack; Deathrender; Apprentice Necromancer;

● Copies > Mimic Vat; Flameshadow Conjuring; Nightmare Shepherd; Skitterbeam Battalion;

YOINK! Want to really avoid the cost of sacrificing? Try threaten effects!

● Captivating Crew; Coercive Recruiter; Firbolg Flutist; Angrath, the Flame Chained;

BRING ‘EM BACK You’re in Rakdos! Which means things that are dead, don’t stay dead.

● Phyrexian Delver; Puppeteer Clique; Body Launderer; Lifeline;

● Dredge the Mire; Living Death;

0-MANA COST? If you sacrifice a creature with 1 mana value, what can you get?

● Kobolds of Kher Keep (and all other Kobolds); Memnite; Ornithopter; Phyrexian Walker; Shield

Sphere

○ Unfortunately Kethek says no Legendaries, so no Rograkh, Son of Rohgahh;

Asmoranomardicadaistinaculdacar

MALCATOR, PURITY OVERSEER

This is harder to achieve than you think. 3 artifacts entering the battlefield every turn requires WORK.

That being said…
GOLEMS!

● Blade Splicer; Master Splicer; Sensor Splicer; Wing Splicer; Precursor Golem (NOTE: This card is

high-risk, high-reward.)

● Phyrexian Triniform; Triplicate Titan; Masterful Replication;

BLINK GOLEMS!

● Lae’zel’s Acrobatics; Disorder in the Court; Semester’s End; Brought Back;

○ NOTE: Conjurer’s Closet and Teleportation Circle are probably good in this deck but do

not help trigger Malcator.

MORE GOLEMS! You have to make a lot of artifacts to trigger Malcator at the end of turn.

● Artifact Creatures > Myr Battlesphere; Genesis Chamber; Sharding Sphinx; Thopter Assembly;

● Tchotchke Deck > Ethereal Investigator; Academy Manufactor;

● Double Tokens > Anointed Procession; Mondrak, Glory Dominus;

● Copy > Spark Double; Phyrexian Metamorph; Clone Legion; Phantasmal Image

● Recursion > Dance of the Manse; Brilliant Restoration

IS IT EVEN WORTH IT? Is it really worth getting this trigger to go off?



RIA IVOR, BANE OF BLADEHOLD

NOTE: Why does it say, “one or more players” and specify combat damage? Are we future

design-proofing this card?

This card asks a lot for payoff next turn. It wants you to hit people, but deal damage later? I WANT TO DO

DAMAGE NOW! Now, remember, the pen is mite-ier than the sword. Or maybe the Phyrexian Knight is

Knightier than the mite.

MITE MAKES RIGHT What kind of creatures attack but don’t worry about dealing damage? Remember:

NO damage triggers.

● Evasion > Welcoming Vampire; Remorseful Cleric; Smuggler’s Copter;

● Scales with creatures > Adeline, Resplendent Cathar; Silverwing Squadron;

● Double Strike > Bronze Guardian; Shadrix Silverquill; Goring Ceratops

○ Will deal damage on the second hit!

SMALL BUT MITE-Y The mites have no evasion and cannot block… let’s help em out.

● Additional Damage > Divine Visitation; Cathar’s Crusade; Corpse Knight;

● Evasion > Akroma’s Will; Archangel of Tithes; Kaya, Geist Hunter;

● Draw > Rumor Gatherer; Losheel, Clockwork Scholar;

MITE I GO AGAIN Sometimes you just gotta swing, so there are a couple of ways Black can get extra

turns

● Gonti’s Aether Heart (Mites are artifacts!)

● Magistrate’s Scepter (maybe you’re including a proliferate sub theme in the deck?)

● Temporal Extortion (this is never going to resolve)

● Timesifter (combined with a card like Varragoth / Liliana Vess (repeatable) or Vampiric Tutor you

can grab a high MV spell and win this. You might also need to flash Timesifter in with cards like

Emergence Zone or Vedalken Orrery)

MITE-Y HAVE FALLEN Or we could just sacrifice ‘em or use them for additional value

● Card Draw > Skullclamp; Deadly Dispute; Bankrupt in Blood; Blood for Bones (recursion too!);

Eaten Alive; Plumb the Forbidden

● Removal > Bone Shards; Bone Splinters;

● Ramp > Culling the Weak

● Protection > Scapegoat

● Aristocrats > Blood Artist; Elas il-Kor, Sadistic Pilgrim; Disciple of the Vault; Marionette Master;

URTET, REMNANT OF MEMNARCH

This is a sweet Myr deck, but it isn’t *just* a Myr deck.

SMOKE & MYRS What are the playable myrs?

● Mana Myrs > Palladium Myr, Iron Myr, Gold Myr; Silver Myr, Plague Myr; Leaden Myr; Alloy Myr;

Copper Myr; Myr Convert;

● Solid Myrs > Myr Welder; Myr Propogator; Shimmer Myr;

● Token Myrs > Genesis Chamber; Mirrodin Besieged; Myr Turbine; Myr Reservoir;

● Maskwood Nexus



UNTAP THAT Whenever a Commander says untap, we must listen to the word of Josh Lee Kwai, and have

to plan to tap and untap as much as possible.

● Tap - Cryptolith Rite; Earthcraft; Song of Freyalise; Urza, Lord High Artificer; Jaheira, Friend of the

Forest; Citanul Hierophants

● Untap - Myr Galvanizer; Unwinding Clock; Clock of Omens;

HASTY MYRS Haste is very important in activated ability decks because a board wipe can undo

EVERYTHING.

● Brudiclad, Telchor Engineer; Alibou, Ancient Witness; Dynaheir, Invoker Adept; Thousand-Year

Elixir;

MYR, MYR…
● Myrror Entity

● Myriad Landscape; Myrari’s Wake; Myrage Myrror; Myrrormade; Emyr, Lurker of the Loch

OUR FAVORITE COMMANDER FROM ONE?

Jimmy = Atraxa, Grand Unifier

Rachel = Kethek, Crucible Goliath

MOST POWERFUL COMMANDER FROM ONE?

Jimmy = Urtet, Remnant of Memnarch

Rachel = Atraxa, Grand Unifier

3) TO THE LISTENERS

What do you think of the new All Will Be One multicolored Commanders? Are you planning on building

any of them? Are there any synergies or combos that we missed?

**CARD KINGDOM #2** **ULTRA PRO #2** **GK LIVE PHILLY**

4) THE END STEP

N/A

5)  CLEAN-UP STEP

Big thanks to our amazing team here at The Command Zone! Damen Lenz; Arthur Meadowcroft; Ladee

Danger; Manson Leung; Craig Blanchette; Josh Murphy; Jake Boss; Jordan Pridgen; Sam Waldow;

Gaurav Gulati; Jamie Block; Mitch Trafford; Evan Limberger; Gabriel Pozos; Megan Yip; Eric Lem and

Josh Lee Kwai.


